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Introduction

Reference Management Tool :-

Use to storing and organizing references, generating citations and bibliographies in 
the preferred style and easily converting referencing styles to suit publication 
requirements.

Examples of reference management tools

Previously, we are 

creating citation and 

bibliography  by 

manually. We spent 

lot of time to do this



Introduction

● A citation is the way you tell your readers that certain material in your work
came from another source. It also gives your readers the information
necessary to find that source again, including information about the author,
the title, date & page numbers of the material.

● References and bibliography provides the information necessary for readers
to identify and retrieve each work cited in the text. In addition, bibliography
may also include other sources consulted even if they not directly cited in the
paper.

● Further information on citation and
reference for UPM students:

https://sgs.upm.edu.my/thesis-2977

https://sgs.upm.edu.my/thesis-2977


Introduction



What is Mendeley?

Mendeley is a free citation and paper management tool 
with up to 2 GB of cloud storage. 

Mendeley has a desktop application, mobile app, and 
making it easy to use across multiple devices.

Cross-Platform (Windows/Mac/Linux/Mobile).

All Major Browsers.



What is Mendeley?

➢ Mendeley is a reference manager allowing you to
manage, share, read, annotate and cite your
research papers

➢ It can help you manage your sources and
organize citations in accordance with whichever
citation format you follow

➢ It can generate references, citations and
bibliographies in a whole range of journal styles
with just a few clicks.

➢ It is a research network to manage your papers
online, discover research trends and statistics,
and to connect to like-minded researchers.



Who used Mendeley?

Mendeley is now being used by over

6 MILLION 
users/researchers worldwide and 

30 MILION references



How do you use Mendeley?

Desktop 

Web 

Mobile 

Mendeley’s Desktop - offers the most complete experience -
allowing you to organize, collaborate and discover, as well as 
use the citation plugin to cite as you write in Microsoft Word. 

Web and Mobile - offer you the ability to access your 
references on the go, as well as making notes and annotations



How does Mendeley Help?



Mendeley Term

Before we get started, here are some terms you should be familiar with:

• Mendeley Desktop: Mendeley Desktop is the downloaded part of the software 
installed onto your computer. Download Mendeley Desktop if you haven’t 
already.

• Mendeley Web: This is the Mendeley website where you can access the web 
version of your library, edit your profile and search for papers, groups or people.

• Sync: The process of synchronizing your Mendeley data across devices.

• Web Importer: The browser bookmarklet that lets you quickly import documents 
from anywhere on the web.

• Citation Plugin: A plugin you can install that allows you to create and format your 
citations and bibliography according to your chosen style.



Getting Started with Mendeley
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Create Account



Mendeley Web 



Mendeley Web Interface



Mendeley Web Interface

Social Features allow users 
to build an online profile to 
promote themselves and 
their work as well as 
connecting with other users. 

PROFILES
- generated at the time of 

account creation, but extra 
information can be added 
to reflect career activity 
and interest.

- An active Mendeley 
account also makes it easy 
for other users to connect 
with you .

- Mendeley integrated with 
ORCID, the Open Research 
Contribution ID non profit, 
to bring unique research 
identification to Mendeley 
Profiles 



Mendeley Web Interface

Click to view your Library



Mendeley Web Library Interface

- Allows you to access your 
Mendeley Library from 
any modern web browser.

- Similar user interface to 
Mendeley Desktop.

- Allows importing, reading 
annotation, organization, 
searching & (limited) 
collaboration via group.

- Design for quick access 
reading & annotation

- Can be used on any 
computer with an Internet 
connection.

- RESTRICTION : Citing is 
not as straightforward as 
on Mendeley Desktop. 
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Mendeley Web Library Interface



Mendeley Web Library Interface



Mendeley Desktop 



Mendeley Desktop : How to Install

1. Sign in to Mendeley

2.     Click Download Mendeley

3.     Click Download Mendeley    
Desktop

4.     Save Mendeley Desktop to 
your hard drive

5.      Double click the Mendeley 
Desktop icon in your browser’s 
download Window and follow the 
instructions on screen.



Mendeley Desktop : How to Install



Mendeley Desktop : How to Install



Open Mendeley Desktop



Mendeley Desktop : Interface

Mendeley Desktop offers 
three-column view.

1. The left-hand  panel 
allows you to navigate 
through different filtering 
options for your library. 

When you click on different 
folders or groups listed in 
this column, different lists of 
papers will be returned in 
the main panel. 

In this screenshot we have 
‘All Documents’ selected, 
which means the main panel 
is listing all of our references.



Mendeley Desktop : Interface

2. The middle panel allows 
you to select individual 
references. 

Clicking on a reference listed 
here will display this 
document’s details in the 
right-hand panel. 

You can also select multiple 
papers to undertake bulk 
actions, such as mass 
deletions or additions to 
folders.



Mendeley Desktop : Interface

3. The right panel shows 
the details of your selected 
reference. 

You can also use this panel to 
modify the details by clicking 
into the individual fields. 

You should carefully check 
and correct the details 
displayed in this panel as 
ensuring accuracy here will 
ensure that your citations 
are totally correct.



Organize
Setting Up A Library



Organize : Setting Up A Library

9 ways to add documents to Mendeley:

1. Add directly from the Mendeley Research Catalog (web only)

2. Add directly from the Literature Search (desktop only)

3. The file menu : Add File / Folder (web/dekstop)

4. The watch folder (desktop only)

5. Add Entry Manually (web/dekstop)

6. Import from another reference manager, or BibTeX (web/dekstop)

7. Drag & Drop Files or Folders (web/dekstop)

8. While browsing web pages/ databases/google scholar/ library catalog 

– web importer (web/dekstop)

9. Synchronize across devices (web/dekstop)

Adding References & Document



Organize : Setting Up A Library

1. Add directly from the Mendeley Research Catalog

Mendeley Research 
Catalog

- The Mendeley research 
catalog is now one of the 
world’s largest open 
databases of research

- You can find the paper 
you’re looking for on 
Mendeley and add it to 
your library. If the 
author himself is on 
Mendeley , you may be 
able to get a copy from 
him directly
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Organize : Setting Up A Library

2. Add directly from the Literature Search

Literature Search
- Click literature search 

button



Organize : Setting Up A Library

- Choose any selected document
- Click Save Refences



Organize : Setting Up A Library

3. The File Menu : Add Files

The File Menu : Add 
File/Folder

- You can choose to add 
individual files, or the 
contents of an entire 
folder by browsing to the 
relevant location on 
your computer.



Organize : Setting Up A Library

4. The Watch Folder
The Watch Folder

- You can setting  to 
‘watch’ a folder - which 
will mean that Mendeley 
monitors that location 
for any new items being 
dropped into the folder.

- If it finds a new 
document, that 
document will be 
automatically added to 
your Mendeley library.



Organize : Setting Up A Library

5. Add Entry Manually

Add Entry Manually 

- You also have the option 
to create a reference 
manually - which will 
allow you to complete a 
number of fields by 
hand.



Exercise

Page: 291



Organize : Setting Up A Library

6. Import from another reference manager, or BibTeX

Import from another reference 
manager, or BibTeX

- You can easily import a 
library from other reference 
managers, so if you’ve tried 
out EndNote, Reworks or 
another solution and found 
them not to your liking, you 
can carry across your library 
to Mendeley easily.



Organize : Setting Up A Library

7. Drag & Drop Files or Folders

Drag & Drop Files or Folders

- If you’ve got a loose collection 
of PDFs that you’d like to 
quickly add to Mendeley, you 
can simply drag & drop them 
onto the open Mendeley 
window.



Organize : Setting Up A Library

8. While browsing web pages (web importer)

Install the Web Importer 
bookmarked to save 
references to your library 
directly from the page of the 
database you’re browsing. 

This is definitely one of the 
easiest ways to add 
documents. Just click the 
toolbar button as you come 
across a paper you’d like to 
save. 



Organize : Setting Up A Library

Installing the Web Importer Choose the appropriate web 
browser. 

After installing the Mendeley 
Web Importer you will find 
the Mendeley Web Importer 
in your tab browser
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Organize : Setting Up A Library

Installing the Web Importer 

Allow
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Organize : Setting Up A Library

Web Importer 
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Organize : Setting Up A Library

Web Importer 



Organize : Setting Up A Library

9. Synchronize across devices
When you click Sync in 
Mendeley Desktop, your 
Mendeley library data will 
be securely stored on the 
Mendeley servers so you 
can access it on any 
machine anywhere you go. 

Notes and annotations 
made in groups will also be 
available to others after 
clicking Sync.



Organize
Managing Your Library



Organize : Managing your library

Use column
headings
to order your 
references

Mark entries
read or unread

Entries with 
attached PDFs
can be opened
with the PDF
Reader

Star items to
mark them as
favorites

All items in
your personal
library

Items added 
in the last two
weeks

Access your
recently read
items

All items you’ve
starred in your
library

Items in need
of review

Items you set as 
My Publications



Organize : Managing your library

References not added to a folder 
will appear in ‘unsorted’

Your folders will be listed below.
Drag and drop to re-order them.

Use ‘Create Folder’ to enter a
new folder name.

Create and Use Folders



Organize : Managing your library

Search Your Documents
Enter your search term
in the search field

The main view will be
filtered accordingly

Click on a specific folder
to search within it

Use the clear button to
remove the search filter

Mendeley’s search tool
will look at reference 

metadata, but will also 
search within the full text

of PDF papers.



Organize : Managing your library

You can also filter by Author,
Author Keywords and
Publication

Search Your Documents
Add tags to papers in your 
library which share a common
theme

Use the Filter Menu to filter
your library view to only include
tagged items



Organize : Managing your library

Search Your Documents

You can also filter by Author,
Author Keywords and

Publication

Add tags to papers in your 
library which share a common
theme

Use the Filter Menu to filter
your library view to only include
tagged items



Organize : Managing your library

Checking for duplicates



Organize : Managing your library

Checking for duplicates

Click 
Confirm Merge



PDF Viewer
Highlight and Annotate Documents



PDF Viewer : Highlight and Annotate Document



Cite
Using the Mendeley Citation Plug-In
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Introduction - Why citing sources?

• To giving credit to the original author.
• Use other people’s work without plagiarizing.
• Helpful to anyone who wants to find out more about your 

ideas and where they came from.
• Your ideas support with fact.



Cite :Using the Mendeley Citation Plug-In  

Install the Citation Plug-in



Cite :Using the Mendeley Citation Plug-In  

Finding a Citation Style



Cite :Using the Mendeley Citation Plug-In  

Generate In-Text Citations in Word



Cite :Using the Mendeley Citation Plug-In  

Merging Citations



Cite :Using the Mendeley Citation Plug-In  

Inserting Your Bibliography
Click 

“Insert Bibliography”

List of bibliography will 

appear from A-Z





ADDED 
INFORMATION
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THANK YOU


